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Preface 

Installation

For instructions on installing CGM MEDISOFT Reports Professional, see the Reports Professional 
Installation Guide.

Where to Find Help 

Online Help 
No matter where you are in CGM MEDISOFT, help is not far away. Access the online Help screens 
to find detailed information on each feature in CGM MEDISOFT. Online Help is available in two 
different ways: 

Main Help File 
To access the main help file, click the Help menu and select Help Topics.   

The main help file will appear displaying the Contents tab. Use the Contents tab to view 
categorized topics. Use the Index and Search tabs to find out additional or specific information. 

Training 
There are various training options available. Please contact your local Value-Added Reseller for 
information concerning these options. 

Independent Value-Added Resellers 
There are Value-Added Resellers in your market area who are knowledgeable and efficient in 
selling, installing, troubleshooting, and supporting your CGM MEDISOFT program. Search the 
CGM MEDISOFT website at www.medisoft.com for a reseller in your area. 

CGM MEDISOFT Versions

Different versions of CGM MEDISOFT provide different levels of reporting.

Reporting Feature Basic Advanced Network 
Professional

Reports 
Professional

Export to Microsoft Excel x x x x

Day Sheets x x x x

Audit Reports x x x x

http://www.medisoft.com
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Contents  Preface 

CGM MEDISOFT Reports Professional is an add-on product for CGM MEDISOFT Advanced and 
CGM MEDISOFT Network Professional, purchased separately. It provides many additional reports 
not found in CGM MEDISOFT Advanced or Network Professional. In addition, it offers report 
creation tools for more detailed analysis of your practice. You can find a detailed comparison of the 
reports found in CGM MEDISOFT Advanced and Network Professional with those provided in 
CGM MEDISOFT Reports Professional in the section “Report Descriptions ” on page 79.

Contents

The three chapters of this guide discuss the components of CGM MEDISOFT Reports 
Professional:

Analysis Reports 6 reports 13 reports 15 reports 15 reports

Aging Reports 2 reports 4 reports 4 reports 4 reports

Collection Reports x x x

Activity Reports x x

Aging Power Pack x

Facility Financials x

Focus on Chiropractic x

Focus on Managed Care x

Focus on Financials x

Focus on Marketing and Promotion x

Plus Pack x

Reporting Feature Basic Advanced Network 
Professional

Reports 
Professional

Component Description

Instant Reports Instant Reports is a reporting tool that produces reports using data fields in 
CGM MEDISOFT that users select on-the-fly. For more information, see 
“Instant Reports” on page 1.

Reports Creation This is the core feature of CGM MEDISOFT Reports Professional. Use it to 
create custom reports for CGM MEDISOFT. Select the data you want to 
display on a report and then design the report to suit your needs. The query 
designers give you the ability to precisely control the data that is presented 
on your reports. For more information, see “Creating Reports” on page 11. 

Report Server The Report Server is similar to CGM MEDISOFT Reports (installed with 
CGM MEDISOFT) but with the additional functionality of scheduling and 
delivering reports. Use this to define, schedule, and deliver a report. For 
more information, see “Automatic Report Generation and Delivery” on page 
61.
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Chapter 1 - Instant Reports

The Instant Reports application can read selected fields on CGM MEDISOFT and Office Hours 
data entry screens, and then produce a report instantly. 

Here are some ideas of how you can use Instant Reports to make your job easier: 

 • Print a chart label for a new patient from the Appointment Entry screen in Office Hours. 
 • Print a patient cover sheet for inclusion in a patient’s chart from the patient entry screen. 
 • Print a mailing label for a referring provider from the patient chart screen. 

Instant reports are not a separate, different kind of report created in CGM MEDISOFT Reports. 
Any report in the CGM MEDISOFT Reports package can be used as an Instant Report; Instant 
Reports put together the information for the screen that will be read, the report that will be used, 
the fields that will be used for data filters, and where the report will be sent after it is generated. 

Two separate programs are included with CGM MEDISOFT Reports Professional for the Instant 
Reports feature. 

 • Instant Reports Manager – Use this to create and edit Instant Report definitions. This is 
where you set up which report will be used, the fields on CGM MEDISOFT and Office Hours 
data entry screens that will be read for report filters, and the destination printer. 

 • Instant Reports Pop-Up – This program runs automatically every time your computer is 
started. It waits for you to press the activation hot key or click the program’s icon in the System 
Tray. 

Both programs are found by clicking Start, pointing to All Programs, and clicking the CGM 
MEDISOFT Reports Professional menu.

Instant Reports Manager 

To launch Instant Reports Manager:
 • Click Start, point to All Programs, point to CGM MEDISOFT Reports Professional, and click 

Instant Reports Manager.
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New Instant Report Chapter 1 - Instant Reports

This is the main screen of Instant Reports manager: 

Figure 1.  Instant Reports Manager screen

The Instant Reports Manager is used to create and edit Instant Reports settings. Instant Reports 
comes with several pre-defined Instant Reports definitions. 

You have three options on this screen:

New Instant Report 

Creating an instant report consists of 5 basic steps:

1. Indicate a report name

2. Identify the screen to pull information from.

3. Identify the folder to pull the report from.

Option Description

Create new Instant Report Click this to create a new report.

Edit existing Instant Report Click this to edit an existing report.

Delete existing Instant Report Click this to delete an instant report.
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Chapter 1 - Instant Reports New Instant Report 

4. Choose fields to use as filters for data elements to include on the report.

5. Print the report or export the report to a file.

Click Create new Instant Report on the left side menu to start the Instant Report Entry. See 
Figure 2.

Figure 2.  Instant Report Entry screen - Step 1
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Step 1: Report Name – Enter the name for this Instant Report. In this example, use an Instant 
Report to print a patient label from the Office Hours appointment entry screen. 

Figure 3.  Instant Report Entry screen - Step 2: Report Screen

Step 2: Report Screen – Identify the screen, either from CGM MEDISOFT or Office Hours, to 
pull information from. To do this

1. Start CGM MEDISOFT or Office Hours.

2. Display the screen you want to use. 

3. Move the Instant Reports Entry screen to the top (click the Instant Reports Manager button on 
the bottom of your screen in the task bar), 

4. Place your mouse cursor over the screen you want to use. When a valid screen is found, the 
Instant Reports Entry screen displays the name of the screen.

In this example, an Instant Reports to print the Appointment Entry screen will be created. 

Many fields in CGM MEDISOFT and in Office Hours can be used for the Instant Report definition. 
The following screens are available to pull information from: 

 • Transaction Entry 
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 • Claim Management Entry 

 • Statement Entry 

 • Worklist Entry 

 • Quick Ledger 

 • Quick Balance 

 • Deposit List 

 • Deposit Entry 

 • Case Entry 

 • Contact Entry 

 • Office Hours - Appointment Entry 

 • Office Hours - Main Screen
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New Instant Report Chapter 1 - Instant Reports

Step 3: Choose Report – Select the report from CGM MEDISOFT Reports to use for this Instant 
Report definition. The existing report you choose here is the template for the report you are 

creating. 

Figure 4.  Instant Report Entry - Select Report screen

Step 4: Link Filters – Select the field or fields on the CGM MEDISOFT or Office Hours screen to 
use as a report filter. In this example, a patient account label for one specific patient is being 
created. A patient is identified with a chart number, so you will select the Chart field in the 
Appointment Entry screen to use as the data filter. 

To select a data filter:
1. Move the Instant Report Entry Step 4: Link Filters screen so that you can see the CGM 

MEDISOFT screen containing the fields you want to filter by. 

2. Click the button at the bottom of the screen in the task bar. 

3. Place the cursor over the Chart field on the appointment entry screen and “This is a valid field” 
will display in the wizard screen. 
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Chapter 1 - Instant Reports New Instant Report 

4. Press the F2 key on your keyboard to select this field for a data filter. Leave the other data 
filters blank. 

Figure 5.  Instant Report Entry - Step 4: Link Filters screen

Note: Not all fields can be selected for use as a data filter. Eligible fields will display “This is a valid 
field” when your cursor is over the field. 
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New Instant Report Chapter 1 - Instant Reports

Step 5: Setup Printing – Define what will happen to the Instant Report after it is generated. The 
report can be sent directly to a printer or previewed before printing. The report can also be 
exported to a file.

Figure 6.  Instant Report Entry - Step 5: Setup Printing screen

After you click Next, the report will be previewed on the screen.

Figure 7.  Patient Label
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Printing or Exporting an Instant Report 

After you have created your first Instant Report, the Instant Reports Pop-Up application will start 
automatically each time your computer starts. An icon showing that it is running appears in the 
System Tray in the lower-right corner of your computer display, next to the time: 

Figure 8.  Instant Reports icon in the System Tray

When the screen you are currently using in CGM MEDISOFT or Office Hours can be used with an 
Instant Report, the MR icon changes color to green. Otherwise, the icon is red. 

Step-By-Step Instant Reports Printing 
1. Select the data entry screen from which to print (click the screen, the title bar changes color, 

and the MR icon in the System Tray turns green to indicate that this screen has an Instant 
Report assigned to it). 

2. Click the green MR icon in the System Tray or press Alt-F7 to display the Instant Reports 
report selection screen. 

Figure 9.  CGM MEDISOFT Reports Instant Reports screen

3. Select the report to produce and click the Print button. 
4. Generate the report. 

Desired Output Selected option button on the Instant Report Entry - Step 5 
Setup Printing screen that causes this

Print the report I want to print this report without previewing.
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Step-By-Step Instant Reports Printing Chapter 1 - Instant Reports

 

Preview the report I want to preview this report before printing.

Export the report to a file Export Report to File

Desired Output Selected option button on the Instant Report Entry - Step 5 
Setup Printing screen that causes this
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Chapter 2 - Creating Reports 

In addition to Instant Reports, CGM MEDISOFT Reports Professional comes with another report 
tool that you can use to create reports or edit existing reports provided in CGM MEDISOFT 
Advanced or CGM MEDISOFT Network Professional. This reporting tool is the CGM MEDISOFT 
Reports Developer. With it, you can select the data fields that you want to include in a report and 
then design the header, body, and footer of a new report with information tailor-made for your 
needs. You can also use CGM MEDISOFT Reports Developer to modify the reports that came with 
CGM MEDISOFT Advanced or CGM MEDISOFT Network Professional. 

Launching CGM MEDISOFT Reports Professional 

You can launch the program in two different ways: 

 • In CGM MEDISOFT, On the Reports menu, click CGM MEDISOFT Reports. 
 • Click Start, point to All Programs, point to CGM MEDISOFT Reports Professional, and click 

CGM MEDISOFT Reports Professional. 
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Identifying Existing Reports

The first screen you see when you open CGM MEDISOFT Reports Professional is the Reports 
Explorer. 

Figure 10.  Reports Explorer screen

The Reports Explorer screen works like Windows Explorer. Report categories will appear on the 
left, while subcategories and individual reports will display on the right. These reports are the 
standard reports installed with CGM MEDISOFT Reports Professional or reports you created using 
CGM MEDISOFT Reports Professional. 
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Creating New Reports

Select New Report or Edit Report from the File menu of the Reports Explorer screen in CGM 
MEDISOFT Reports Professional. The Report Developer screen appears. This is the screen you 
will use to create a new report or edit an existing report.

Figure 11.  Report Developer screen

The Report Developer screen has four primary work areas, all designated by tabs in the developer 
screen: 

Workspace Area on Report Developer screen Purpose

Data Retrieve data from CGM MEDISOFT files 
for inclusion in a report. For more 
information, see “Data Workspace” on 
page 14.

Calc Conduct advanced data manipulation. For 
more information, see “Calc Workspace” 
on page 32.
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To create a new report:
1. Use the Data tab to create a query that will determine the data that is included in the report.

2. Use the Design tab to arrange fields of data on the report, create labels for columns of data 
and sections of the report, and add header and footer information. 

3. Use the Preview tab to see how your report will look. 

4. Establish developer properties, such as the author of the report and a password to access it.

5. Export the report as a file for use on other computers or create a CD/DVD for the report.

Data Workspace
The Data tab is used to gather the information from your CGM MEDISOFT practice. This data 
gathering is called a query. 

CGM MEDISOFT Reports Developer has two ways to build a query: The Query Wizard and the 
Query Designer. The Query Wizard is the simplest option to use. Use the Query Designer to edit 
an existing query or access more comprehensive query capabilities, including the ability to edit the 
code created for the query and enhanced calculation, filtering, and sorting capabilities. Use these 
methods to assemble all of the data that you want to include on your new report. 

Using the Query Wizard  
The Query Wizard is a simple, step-by-step tool that walks you through creating a query for a new 
report. 

To use the Query Wizard: 
1. Select the Data tab on the Report Developer screen. 

Design Set up the visual layout of a report. For 
more information, see “Design Workspace 
” on page 35.

Preview Preview the report as it is developed. For 
more information, see “Preview 
Workspace ” on page 50.

Workspace Area on Report Developer screen Purpose

To use the... see...

Query Wizard “Using the Query Wizard  ” on page 14.

Query Designer “Using the Query Designer ” on page 22.
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2. On the File menu, click New. The New items screen will appear.

Figure 12.  New Items screen

3. Select Query Wizard and click OK to start the wizard. 

Figure 13.  Query Wizard screen - Select Tables

4. Select the table(s) to include in the query by highlighting one on the left and clicking the top 
arrow. Tables contain the data for the practice (patient, facility, and so on). It’s best to select 
the primary table first and then the secondary tables that will supply supplementary 
information. Example: If you are building a patient list report, select the Patient table. To build a 
transaction-based report that also needs to include patient and case information, select the 
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Transaction table and then select the Patent and Case tables. In this example, the Transaction 
and Patient tables are selected. 

Figure 14.  Query Wizard with Transaction and Patient Tables selected

CGM MEDISOFT Reports Developer needs to know how these tables are related. A Join relates 
the tables and allows any field from the Transaction table and any field from the Patient table to be 
used in a report. 

Be sure to select tables that have data you might want for the header and footer of your report, 
such as Practice Name. 
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5. Select the transaction table in the right pane of this screen and then click the Join button. The 
Join Table screen appears.

Figure 15.  Join Table screen

The Transaction and Patient tables are related only by the patient Chart Number field. You can 
create joins by selecting one field from the Patient table and one field from the Transaction 
table and then clicking the Add button. 

6. Click the OK button when you are done creating joins.
7. Click the Next button.
8. Select Choose Fields.
9. Choose the fields to include in the query. These would include the data you want in the body of 

the report, as well as Header fields, such as Practice Name. 
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eMDs recommends that you include only those fields needed for your report. Retrieving 
unnecessary fields will affect the query’s performance. 

Figure 16.  Query Wizard screen with Selected Fields

10. Click the Next button when you are done.
11. Select Add Calculations.

Figure 17.  Query Wizard screen - Calculations

The most common use for a calculated field screen is to total or subtotal an amount field. 
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12. Select Transaction.Amount from the field list and the Calculated Fields screen appears: 

Figure 18.  Calculated Fields screen

13. Select the calculation function to perform from the Function drop-down list.
14. Click the OK button.
15. Click the Next button. The Query Wizard - Grouping screen appears.

Figure 19.  Query Wizard - Grouping

Grouping allows the query to summarize information. The application can group in the query 
or in the visual designer. When grouping the information in a query, all fields selected for 
inclusion must also be selected for grouping, and they must be listed in the same order.  

Grouping in the visual designer (on the Design workspace) is more appropriate when you want 
to print subsections in the final report, as in a ledger-style report.

16. Click Select Group Fields.
17. Add Transaction.amount to the Selected Fields section.
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18. Click the Next button. You can limit the rows (data items) that will appear in the report.

Figure 20.  Query Wizard - Limit Rows screen

If you select Define Search Criteria, you can specify items to limit the data that is returned for 
the report; for instance, if you want to limit the report to patients who live in a certain city or zip 
code.

19. Select All Rows and click the Next button. 

Figure 21.  Query Wizard - Order screen
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20. Now, you can determine the order of the rows of data in the report. The data in the query’s 
result can be returned in its natural order of occurrence in the primary table or it can be 
returned sorted. The Order screen allows the query sort order to be defined: Records in the 
transaction table are normally entered in chronological (date) sequence, but not always. It will 
be most effective to sort the result table for a transaction query in chart number or date-from 
sequence.

21. Select Set Order.
22. Highlight Transaction.ChartNumber in the Available Fields box and click the top arrow to move 

it to the Selected Fields box.

Figure 22.  Query Wizard - Set Order

23. Click the Next button. 
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24. Enter a Name for your new query

Figure 23.  Query Wizard - Query Name

25. Select Return to data workspace.
26. Click the Finish button. 

Figure 24.  Data Workspace with completed query table

Using the Query Designer 
The Query Designer is another tool for creating data queries. Although the Query Wizard is 
simpler, the wizard limits the type of query that can be built. You have more capability with the 
Query Designer.
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To open the Query Designer: 
1. On the File menu of the Data workspace tab of Reports Developer, click New.
2. Select Query Designer. The New Items screen appears.
3. Click the OK button.

Query Designer screen
Tabs exist for each function available in the Query Designer. Note that each tab corresponds to a 
screen or set of screens found in the Query Wizard. Essentially, you use the Query Designer to do 
all of the report creation via tabs that you did in the step-by-step Query Wizard.

Figure 25.  Query Designer screen

Tables Tab
Select the data table or tables that will be used in the query. 

To select a table:
1. Find it in the Available Tables section of the tab and double-click it. It will appear in the 

Selected Tables section of the tab. Select the primary table for the query first. The primary 
table is where the key information for the report is found. In a financial report, this will likely be 
the transaction table. 
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2. Select the secondary table or tables. Selecting the Patient table will allow patient names to be 
associated with the transaction information in the first table selection. 

Figure 26.  Query Designer screen - Patient Table selected

When you select a secondary table, the Join Tables screen will appear and allow you to specify 
how the information is linked, just as in the Query Wizard. Tables need to be related to each other 
to allow information from one table to be matched with information in another. Specifying this 
relationship is called a Join. You can join only two tables together at once; however you can join 
the second to the first and then the third to the second, and so on. Normally, CGM MEDISOFT 
Reports Developer will automatically create a join but you can change it. 

Joins will not only allow the contents of tables to be related, but they also control which records are 
retrieved for the result. From the Join Type drop-down, you can select different types of joins. There 
are four Join Types in CGM MEDISOFT Reports Professional:

Create a join between the Patient table and the Transaction table like this: 

Join Type Description

Inner Use this type to retrieve records from a table only if there is a matching record 
from the joined table. Inner joins are more common than others, and the 
application will automatically create in Inner join when you add more than one 
table to a query. 

Right Outer Use this type to retrieve all the values from an inner join plus all values in the 
right table that do not match to the left table.

Left Outer Use this type to retrieve all the values from an inner join plus all values in the 
left table that do not match to the right table.

Full Outer Use this type to combine the effect of applying both left and right outer joins. 
Where records do not match, the result will have no values for every column 
of the table that lacks a matching row. For those records that do match, a 
single row will be produced (containing fields populated from both tables).
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1. Click one table in the Selected Tables screen to highlight it. 
2. While the Reports Developer will normally automatically create a join between tables, to 

manually join tables or verify a join, click the Add button. 
3. The Join Table screen will appear. 

Figure 27.  Join Table screen

4. On the right are the fields from the Patient table, and on the left are the fields from the 
Transaction table. Different fields will be listed depending on the tables that you are joining. 
Selecting a field on the left and a field on the right will allow a join to be added. 

Select the Distinct check box on the Tables tab if you want to suppress duplicate values when you 
choose the fields that will be part of your query.

Do not click the OK button until you have completed all of the tabs. You may get an error if you do. 

Fields tab
Select the fields that will be used for the report. It is important that only the necessary fields are 
selected. Selecting unneeded fields will affect the speed of a query because of the quantity of data 
retrieved. 
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Select a field by double-clicking the field in the Available Fields section or dragging and dropping a 
field into the Selected Fields section. 

Figure 28.  Query Designer - Fields tab

Calcs tab
This tab is used for performing simple mathematical operations on query data. The Calcs tab in the 
Query Designer has different uses than the Calc workspace in the Reports Developer, however. 

Figure 29.  Query Designer screen - Calc tab
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Standard functions available in a calculation include Average, Count, Maximum, Minimum, and 
Sum. 

For those familiar with SQL (Structured Query Language), the Expression selection allows an SQL 
statement to be entered. Supported SQL statements include these:

 • Aggregate column functions 
 • Date/time functions
 • Math functions 
 • String functions 

A complete listing of the SQL functions supported is available in the Advantage Database help file, 
or the ADS_SQL.pdf file, found in C:\Program Files\CGM MEDISOFT\Bin\Help 

To perform a calculation on a field

1. Double-click the field to add it to the Calculations section of the tab. 
2. Click the value in the Function column and select a calculation from the drop-down list.

Search tab
Use the Search tab to select or limit the data to be included in a report. Double-click a field in the 
Available Fields section or drag and drop a field into the Criteria section to create a data filter for a 
query. 

Figure 30.  Query Designer - Search tab

The Operator drop-down list is used to select the comparison method for the data filter.

Operator Type of Operator

= (equal) Use this as a standard comparison.

<> (not equal to) Use this as a standard comparison.

< (less than) Use this as a standard comparison.
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<= (less than or equal to) Use this as a standard comparison.

> (greater than) Use this as a standard comparison.

>= (greater than or equal to) Use this as a standard comparison.

Like Use this for a wild card search. It is used to 
find information anywhere in a field. To 
specify a wild card search, use these 
examples: 

 • ab% will select a word in a field that 
begins with “ab” and has any number 
or type of characters following the %.

 • ab will select a word in a field ending 
with “ab”.

 • %ab% will select a word in a field with 
ab occurring anywhere in the field. 

 • The underscore (_) wildcard is used 
like the percent (%) wildcard, but the 
underscore matches a single 
character rather than any number of 
characters. 

 • Enclosing wildcard characters in 
square brackets ([ ]) will match any of 
the characters in the brackets. 

Not Like Use this for a wild card search. It is used to 
find information anywhere in a field. To 
specify a wild card search, use these 
examples: 

 • ab% will select a word in a field that 
begins with “ab” and has any number 
or type of characters following the %.

 • ab will select a word in a field ending 
with “ab”.

 • %ab% will select a word in a field with 
ab occurring anywhere in the field. 

 • The underscore (_) wildcard is used 
like the percent (%) wildcard, but the 
underscore matches a single 
character rather than any number of 
characters. 

 • Enclosing wildcard characters in 
square brackets ([ ]) will match any of 
the characters in the brackets. 

Between Use this as a Range operator. Allows you 
to specify a range of information.

Operator Type of Operator
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Entering search criteria in the Value field stores that criteria with the report definition, giving a 
default data selection filter. 

 • Select the Auto Search check box to ask the data selection question at print time. 
 • Select the Mandatory check box to require an entry in the search field before a report can be 

printed. 
 • Select Show All to set the default data filter to include all records. 

Group tab
The Group tab summarizes records in the result table for a query. The effect of grouping is also to 
eliminate duplicate records.  

Figure 31.  Query Designer screen - Group tab

All fields selected on the Fields tab must appear on the Group tab, and in the same sequence. For 
data to be grouped (summarized) in a result table, all fields specified for grouping must match 
exactly. If grouped data includes an amount field that must be totaled, use the Calcs tab to create a 
calculated field to summarize the amount. 

Not Between Use this as a Range operator. Allows you 
to specify a range of information.

In List Use this to cause a list box to appear 
during report creation for selecting data.

Not In List Use this to cause a list box to appear 
during report creation for selecting data.

Blank Use this to select blank fields.

Not Blank Use this to select fields that are not blank, 
or empty of data.

Operator Type of Operator
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Sort tab
The sort tab allows the records in a result table to be ordered. Double-click or drag and drop a field 
from the Available Fields section into the Sort Fields section. The default sort order is ascending. 
Select the Desc (z > a) check box to reverse the sort order to descending. 

Figure 32.  Query Designer - Sort tab

SQL tab
This tab shows the SQL statements produced as a result of the entries made in the Query 
Designer screen. The name of the query (data pipeline) may also be changed in this screen. 
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Displayed here will be the SQL statement that will be executed to produce a result table for your 
report. 

Figure 33.  Query Designer - SQL tab

CGM MEDISOFT Reports Developer will allow the SQL statement to be directly edited, but avoid 
this if it is possible to produce a desired result with the Query Designer. To edit the SQL statement, 
right-click the SQL screen and select Edit SQL from the menu. 

When an SQL statement is edited, certain standard data query features of the developer are 
disabled: 

 • There will be no opportunity to enter data filters at print time. Your SQL query must perform all 
necessary data selection itself. 

 • Queries may not be linked.  
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A Completed Query 
After completing and saving a query from the Query Wizard or the Query Designer, the query 
screen will appear in the Data workspace like this: 

Figure 34.  Transaction screen with Completed Query

In addition to displaying the fields of the query, the query screen has a toolbar that gives you direct 
access to the tabs of the Query Designer: 

Calc Workspace
There are two different ways of performing simple mathematical functions in CGM MEDISOFT 
Reports Professional. First, you can use the Query Wizard or Designer to make simple 
calculations. These are the easiest way to perform mathematical operations for a report. Second, 
the Calc workspace (Calc tab in CGM MEDISOFT Reports Developer) can also be used for 

Icon Description

Use this icon to run the query and preview the result table. This is an excellent 
diagnostic tool to use when your report is not working as intended.  

Use this icon to open the Query Designer and displays the Tables tab.

Use this icon to open the Query Designer and displays the Fields tab.

Use this icon to open the Query Designer and displays the Calcs tab. 

Use this icon to open the Query Designer and displays the Group tab.

Use this icon to open the Query Designer and displays the Search tab. 

Use this icon to open the Query Designer and displays the Tables tab.

Use this icon to link this query to another query. This button is grayed until there 
are at least two queries displayed in the Data workspace. Click the Link icon in 
the toolbar of the query you want to set as the Detail query. The link screen is 
similar to a Join screen.

Use this icon to open the Query Designer and displays the SQL tab. Click this 
button to Import or Export a Query.
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mathematical operations. In addition to mathematical operations, data manipulation and logic 
operations may be performed in the Calc workspace, making it a more powerful feature than that in 
the Query Wizard or Designer. 

Figure 35.  Report Developer screen - Calc tab

Use the Calc workspace to control elements of a report. Here are descriptions for each part of the 
Calc workspace, as marked above: 

Section of the screen Description

1) Report Bands Use the tree to display all the objects in 
your report including header, detail, and 
footer “bands,” groups, and events for the 
entire report. These are the main sections 
of the report, its “event” categories. 
Clicking a report object (such as Header) 
displays its events (actions taken based on 
the code) in the Variables area (area 2). 

2) Variables Use this area to display all the events for 
the selected report object from area 1. 
When an event is selected, any RAP code 
entered for the event is displayed in area 
3.  
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3) Code Edit and Display Use this section to display the code.

4) Code Toolbox Use this to see the data tables included in 
the report.

5) Fields, Objects, Code Use this section to see three types of 
objects displayed in these areas: 

 • Data pipelines

 • Report objects

 • Code. 

Select the Data, Objects, or Language tab 
in area 5 to display the data fields in a 
query, the objects in a report, or code 
shortcuts. 

Objects displayed in area 5 can be 
dragged and dropped into the code entry 
and edit area (area 3). 

Section of the screen Description
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Design Workspace 
Click the Design tab in CGM MEDISOFT Reports Developer to display the Design workspace. This 
area is used to organize and arrange the visual layout of the report. 

Figure 36.  Report Designer - Design tab, with sections numbered

Below is a brief description of the sections of the screen:

Section of the screen Description

1) Toolbars Use this section to see many of the most commonly used 
functions in the Design workspace. Hover your mouse 
pointer over each tool to display its name. If you want to 
control which toolbars appear, on the View menu, click 
Toolbars. Select the toolbar to display and drag it to the 
desired location on the screen. 

2) Align or space toolbar Toolbars may be docked horizontally or vertically, or they 
may be free-floating. The alignment or space toolbar allows 
rapid access to these frequently used tools. On the View 
menu, point to Toolbars, and then click Align or Space to 
display this toolbar.
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Basic Visual Report Design 
Start by organizing the Design workspace. Display the toolbars you plan on using. Then, display 
the Data Tree section of the Design tab (Section 4 in Figure 36) and drag and drop fields into the 
bands where you want them to print. Alignment and text attributes may be applied to any number of 
objects simultaneously, using the Appearance section of the screen in the bottom left. In addition, 
you can use the Appearance section to control the font, size, and style of labels and data on your 
report. 

Set up your query design to include all the fields you will need for Header, Details, and Footer. For 
more information, see “Data Workspace” on page 14.

To add a field to a report:
1. Click Design to display the Design tab. In this example, the Patient Last Name will be added to 

the report.

Figure 37.  Design tab

3) Report bands Use this to see each band of the report. Drag the sizing 
rulers on the left margin of each band to increase or 
decrease its size. Setting a band’s size to zero hides the 
band. Report objects may be dragged and dropped across 
bands, multiple objects may be selected in any band where 
they are placed, and text attribute and alignment properties 
may be applied across bands. 

4) Report Tree section Use this to display each band of the report and the fields 
placed there. New variable fields placed in a report can be 
named and manipulated in the Report Tree screen. On the 
View menu, point to Toolbars, and click Report Tree to 
display the Report Tree section. 

5) Data Tree section Use this to select a query name in the top section of the 
screen to display all the fields in the query in the bottom of 
the screen. Drag and drop fields from the Data Tree directly 
into the visual report design. On the View menu, point to 
Toolbars, and click Data Tree to display the Data Tree 
section. 

Section of the screen Description
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2. In the Data Tree, click Patient. The list of available fields appears in the Fields for Patient 
section.

Figure 38.  Fields for Patient section of Design tab

3. Click and drag the Last Name field from the Fields for Patient section into the Detail section of 
the Design tab.

Figure 39.  Design tab with Patient Last Name field

Note that when you drag fields, they will include both a label and data field, the label on the 
left. You can put, for instance, a label in the Header and then place the data field below it in the 
Details, and create a column in this way. With the label in the Header, it will not repeat for each 
row included on the report.



CGM MEDISOFT v28
38 v28 December 2023

Basic Visual Report Design Chapter 2 - Creating Reports

4. In the Report tree section of the Design tab, click Label in the Detail folder.

5. Click and drag the label on the left from the Details section into the Header section. This will 
ensure that the column label does not repeat with each patient last name.

Figure 40.  Design tab with field label in Header section

6. Click and drag the Last Name data label so that it lines up under the Last name header label. 
This will ensure that the data aligns correctly on the column.

Figure 41.  Design tab with labels lined up

7. Repeat these steps for other fields that you want on your report.
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To change the appearance of a column label or data in a column:
1. If you want to increasing the size of a column label and change the style to Bold, highlight the 

column label by clicking it.

Figure 42.  Design tab with Last Name column label selected

2. In the Text section of the Properties for Label... section on the left of the Design tab, click the + 
sign next to Font.

Figure 43.  Design tab with Font highlighted
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3. The options open.

Figure 44.  Design tab with Font options displayed

4. Click in the Size field and change the value to 14.
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5. Press the ENTER key. The size of the font for the column label changes. Note that some of the 
label is obscured.

Figure 45.  Design tab
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6. To display the entire label, click the right-hand size bar and drag the label box so that the entire 
label appears.

Figure 46.  Design tab with Last Name column label highlighted
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7. To change the Style to bold, click the + sign on Style in the Text section of the Properties for 
Label section of the screen. This will display style options.

Figure 47.  Design tab with Style options highlighted
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8. Select the fsBold check box. The Last Name column label changes to bold. 

Figure 48.  Design tab with Last Name column label in bold

9. Repeat these steps for other fields and labels in the report. 

The following section describes menu items available in the Design workspace: 

Page Setup
To open the Page Setup screen

 • On the File menu, click Page Setup.
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Use the Page Setup screen to define the destination printer, select the paper size, orientation and 
source, define columns, and set the page margins. 

Figure 49.  Page Setup screen

Print to File Setup 
To open the Print to File Setup screen 

 • On the File menu, click Print to File Setup.
Use this screen to specify the output format (comma delimited, tab delimited, or fixed length) and 
then choose the fields from each band to export. Select the band and field from the Available 
Controls section, and move the field to the Selected Controls section. 
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Naming each field using the Report Tree screen prior to setting up the export details makes this 
easier because each field will be named descriptively. 

Figure 50.  Print to File Setup
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View Menu options
You can show or hide several toolbars and menus, depending on your needs and selections. 

Figure 51.  Report Designer with menu items displayed

Toolbar or Option Description

Standard Components Use this to access these tools: Select, Label (static text), Memo 
(static paragraph text), Rich Text (static formattable text), 
System Variable, Variable (definable contents using Calc tab), 
Image, Shape, Line, Chart (static chart), and Bar Code (static 
bar code).

Data Components Use this to access these tools: DB Text (database field), DB 
Memo (database memo), DB Rich Text (formattable database 
text), DB Calc (calculate fields from a database), DB Image, DB 
Bar Code (print database field as bar code), and DB Chart 
(create chart from query). 

Advanced Components Use this toolbar to access these tools: Region (container for 
other components), Sub Report (report within a report), and 
Cross Tab (summarized data in a grid format). 

Report Tree Use this to display objects in the report (bands, fields) in an 
outline format. See at a glance all the components of the report 
and easily rename components. 

Data Tree Use this to display the report’s data queries, also called Data 
Pipelines. Select a query to see all fields associated with the 
query. Drag and drop fields from the Data Tree directly into 
bands in the visual designer. 
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Standard Use this to access these tools: New Report, Open Report, Save 
Report, Page Setup, Print, Print Preview, Cut, Copy, and Paste. 

Format Use the Format toolbar to access these controls: Font, Size, 
Text Effects, Justification, Text Color, Highlight Color, and 
Positioning. 

Edit Use this to edit the name or type of each report component. 

Draw Use the draw toolbar to control Fill Color, Line Color, Line 
Thickness, and Line Style.

Align or Space Use this to control the alignment and spacing of objects on a 
report. 

Size Use the size toolbar to shrink or grow the width or height of a 
control to the largest or smallest object. 

Nudge Use the Nudge option to move the selected objects slightly left, 
right, up, or down. 

Rulers Use this to turn on or off the sizing rulers in the visual designer. 

Grid Options Use Grid Options to allow the alignment grid to be turned on or 
off in the visual designer. The alignment grid makes rough 
alignment of report objects easier and more accurate.

Show Data Use this to display the contents of data tables while the report is 
being designed. 

Toolbar or Option Description
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Report Menu

Figure 52.  Report Developer screen - Report menu

The Report menu has the following options: 

Menu Option Description

Data Use this to select a data pipeline. A data 
pipeline is a data source for the report, that 
is, a query created using the Query Wizard 
or Query Designer. 

Title, Summary, Header, Footer Use this to display report bands for these 
regions.

Page Style Use this to control a report band that 
allows placement of a graphic or other 
formatting object that will print in its 
entirety as a background on a page. Uses 
for the Page Style band include formatting 
grids or lines, scanned images, and drawn 
regions of a form. 
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Preview Workspace 
The Preview Workspace shows you what the report will look like as it is currently designed. 
Switching between the Design and Preview workspace is an excellent technique to help visualize a 
report as it is created. 

Switching to the Preview workspace will require differing amounts of time depending upon whether 
the report has been saved since the previous preview, the complexity of the report, and the size of 
the data tables for which the report is being designed. 

Performance of the Preview Workspace can be improved by using CGM MEDISOFT tutorial 
sample data or another similarly small data set. Large data sets will significantly delay display of 
the preview, particularly with complicated reports. 

Using the Developer Menu in Reports Explorer

Developer properties are assigned to a report to: 

 • Identify the author of the report 
 • Provide contact information for the author 
 • Permit or prevent editing of the report 

Groups Use Groups to group information on a 
report, as in a master/detail arrangement. 

Multiple groups can be created for a 
report, each of which is sizable and has its 
own group header and footer. Open the 
Groups screen and then select the 
grouping trigger. Data in a query must 
match its intended grouping. Each time the 
grouping trigger changes, a new group is 
created. If query data is not sorted 
properly to support grouping, unexpected 
group breaks will occur.  

Cache Pages Use this to store pages in memory to allow 
rapid movement between preview pages.

Pass Setting Use Pass Setting to control the number of 
times data for a report is traversed, that is, 
scanned and analyzed. Two passes are 
required if a total variable must be printed 
prior to the detail that is totaled or 
accumulated. 

Units Use Units to control the unit of 
measurement used on the Design 
workspace.  

Menu Option Description
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 • Require input of an unlock code when installing a report to protect reports from unauthorized 
distribution

Figure 53.  The Developer menu

Developer Properties 

To open the Developer Properties screen:
 • On the Developer menu in the Report Explorer, click Developer Properties. 

Figure 54.  Report Developer Properties screen - Report Information tab

Developer Properties are assigned to each report and are stored in the report definition file. They 
are transported with a report file when it is exported from the developer and imported into another 
computer. 
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Report Information tab 

Author tab
Use the options on this tab to control what the user can do with the report. 

Figure 55.  Report Developer Properties screen - Author tab

NOTE: Author information must be entered before setting the Author properties of a report. The 
Author Setup screen can be accessed from the Developer menu in the Report Explorer or by 
clicking the Author Setup button on the Author tab in the Developer Properties screen. The Author 

Option Description

Report Name Enter the name of the report. This name is displayed in 
the unlock code screen and in the About Box for the 
report. 

Default Folder Use this to see the name of the Report Explorer folder 
where the report will be placed when it is imported. If 
the folder name does not exist, importing the report will 
create the folder. 

Report Version Use this to enter your internal control number for the 
report release. 

Sales Phone, Support Phone, E-Mail, 
Website

Use this to dispaly contact information in the status bar 
of the Report Explorer when the report is highlighted. 

Description Use this to enter a description of the report (up to 250 
characters). 
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setup screen is described in “Author Setup ” on page 54. 

Option Description

Report ID Enter any alphanumeric code up to 15 
characters. This code is defined by you to 
identify each report.

User Can Edit Use this to permit or prohibit editing of the 
report by another user. 

User Can Export Use this to permit or prohibit exporting of 
the report from CGM MEDISOFT Reports 
or CGM MEDISOFT Reports Developer. 
This setting further controls the ability of 
users to distribute your reports. 

Demonstration Use this to limit printing of a report to one 
page. Using this setting will allow a limited-
use demonstration copy of the report to be 
created. 

Freeware Use this to indicate if you want users to 
enter an unlock code, protecting the report 
from being edited. 

Generate Report Key Use this to generate a confidential key 
code that is used later in the process of 
creating an unlock code for an end-user. 

Warning: Regenerating a Report Key will 
invalidate all unlock codes previously 
issued for a report. 

When a report key has been generated, a 
picture of a key is displayed to the right of 
the Generate Report Key button. 



CGM MEDISOFT v28
54 v28 December 2023

Other Information tab Chapter 2 - Creating Reports

Other Information tab
The Other Information tab displays the date created, the date modified, and the report definition file 
version. 

Figure 56.  Other Information tab

Author Setup 
Use the Author Setup screen to identify a report author and store the author password: 

Figure 57.  Report Author Setup screen

Author setup must be done on every computer in an office that will be creating reports. Enter the 
same Author Name and Author Password on every computer.  

Field Description

Author Name Use this to enter the name of the author of 
the report. eMDs recommends that the 
Author Name be set to your company/
practice name. 
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Generate User Unlock Code 
Use this screen to issue a unique unlock code to each purchaser or user of a report.  

Figure 58.  Generate User Unlock Code for Report screen

Deploying a Report
Once you have created a report, you will need to deploy it so it can be produced and printed. All 
reports created with CGM MEDISOFT Reports Professional reside in a single report database file. 
The database file will be located on the database server if you are using the developer in a client/
server environment, or on the local computer if used in a single-user setting. 

No matter what type of database environment is in use, reports designed with the application must 
be exported to a data file and imported into the CGM MEDISOFT Reports Print Engine on the 
destination computer. You have two options available when deploying a report: Manually import the 
report, or create an installation CD/DVD for distribution of the report.

Author Password Use this to enter any combination of 
characters. Safeguard this password to 
prevent other report creators from having 
access to your report definitions.

Field Description

Field Description

User Name Enter the user’s name as they want it to 
appear in the Report Explorer. This field is 
not case sensitive. Characters other than 
letters and numerals are disregarded. 

Generate Unlock Code Click this button to issue a 16-character 
unlock code.

Copy Name and Code to Clipboard Use this to copy information in a format 
that is suitable for pasting into an email 
message to notify a user of a code for a 
purchased report or for tracking issued 
codes. 
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Exporting a Report 
1. When a report is completed, save the report and close the Developer screen. 

2. In the Reports Explorer, select the report by clicking to highlight the report title.

3. On the File menu, click Export Report. The Export Report screen will display to complete the 
export.  

Figure 59.  Export Report screen

The name of the report will default to the name given the report in the Report Explorer. All 
reports will have a file name extension of .rtm. 

4. Navigate to a location of your choice for exporting the file.

Importing a report

To import the report on the destination computer:
1. Open the Report Explorer.

2. On the File menu, click Import Report. The report title will appear in the Report Explorer with 
the title of the report file as its name. 

Creating an Installation DVD 
Software is included with CGM MEDISOFT Reports Professional to create a self-running 
installation DVD for any report or group of reports. If you want, you can create a DVD for those who 
will install the report on their computers. 
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The first step to create an installation DVD is to export the report file from Reports Professional. 

Open Windows Explorer and browse to the C:\Program Files\CGM MEDISOFT\Bin\MakeInstall 
folder.  In this folder are all the files and folders necessary to create an installation DVD. eMDs 
recommends that you copy all included files and folders in the MakeInstall folder to a separate 
location for each distribution DVD you create. 

Figure 60.  Make Install folder

File or Folder Description

Report Definition Folder Use this folder to place all the .rtm report 
files to be included on the DVD in this 
folder.

Autorun.inf This is the file used by Windows to 
determine which program file to execute 
when a DVD is inserted in the computer’s 
DVD-ROM drive. This file must not be 
changed. 

InstallDef.ini This file contains information to 
personalize the installation for your 
company and report. Edit this file with 
Notepad to personalize the installation. 
See Figure 61 on page 58.
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Figure 61.  InstallDef.ini in Notepad

Field Description

Title Use this to enter the title of the report or 
group of reports to be installed. 

Company Use this field to enter the name of your 
company/practice. 

Contact Use this to enter your telephone number, 
web site address, or other contact 
information. Limit the length of the 
information you enter on this line to no 
more than 100 characters. You can check 
the appearance of the contact information 
on the first screen of the installation 
program by running the installReport.exe 
program after editing the file. 

InstallReport.exe This is the customizable installation 
program. All customizable parameters are 
contained in the InstallDef.ini and 
RepLicense.txt files. Edit this file in 
Notepad to include a click-to-accept 
license agreement, if any, in the installation 
program.
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Figure 62.  RepLicense.txt in Notepad

Create a distribution DVD by copying the entire contents of the MakeInstall folder to the root 
directory of a DVD. Do not copy the MakeInstall folder itself; copy only the contents. 
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Use CGM MEDISOFT Reports Server to automatically generate and deliver reports for CGM 
MEDISOFT. 

CGM MEDISOFT Reports Server Overview

The CGM MEDISOFT Report Server is used for two primary tasks: 

 • Producing reports on a schedule 
 • Delivering reports to the people who need the information 

The report server works with custom reports designed with CGM MEDISOFT Reports Professional 
and the reports found in CGM MEDISOFT Report packs. 

Scheduling Options 
CGM MEDISOFT Reports Server offers many options for scheduling reports: 

 • Reports can be scheduled daily, weekly, or monthly 
 • Reports can be scheduled for one-time production or repeated for any desired time period
 • Reports can be produced for any CGM MEDISOFT data set available to the report server
 • All available data filters may be set in the report schedule 
 • Date filters offer settings for Today, This Week, This Month, This Year, Yesterday, Last Week, 

and Last Month. The appropriate dates are automatically used for the date filter when the 
report is produced 

Delivery Options 
CGM MEDISOFT Reports Server offers several methods of report delivery: 

 • To client software that periodically checks to see if a user has reports waiting. When a report is 
found, the client software notifies the user of this 

 • To client software for viewing reports, report printing, and filing for future reference. This 
software is called Report Server Client and is provided with the CGM MEDISOFT Report 
Server

 • To print automatically on any printer on the network
 • To Adobe Acrobat Reader (.pdf) format and then emailed to a recipient
 • To any number of recipients on a local area network combined with any number of email 

recipients and printed
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Setup

Users
CGM MEDISOFT Reports Server and Client uses a combination of CGM MEDISOFT standard 
security and permissions to determine which users may access reports.  

If you apply standard security to your practice, then you can limit access to report generation and 
viewing on a report-by-report basis by using the CGM MEDISOFT Reports Permissions screen 
and determining what level (1-5) has access to the various reports.

The CGM MEDISOFT Permissions feature provides five levels of access to the program. The 
Security Supervisor/Administrator, who has unlimited access and full control of security, can assign 
or remove rights for any level of security, with one exception.  Level 1 access cannot be removed 
from any of the three options listed in the Security screen settings for the Supervisor.  Lower level 
access can be added, but the Supervisor must retain rights to these options.

Before assigning permission levels to various CGM MEDISOFT Reports, you will need to create at 
least one user (administrator) in the practice. 

Creating Users in a Practice
1. On the File menu in CGM MEDISOFT, click Security Setup.  The Security Setup screen 

appears.
2. Click the New button. The User Entry screen appears. 

Figure 63.  User Entry screen

3. On the Login Name field enter the user's code for logging into the program. 
4. On the Full Name field enter the user's full name.  
5. On the Password field enter the user's password.  This must be a minimum of 8 characters 

and is case-sensitive.
6. On the Reconfirm field enter the same data entered on the Password field.
7. From the Access Level list, select the user's security level.  If you are entering a supervisor/

administrator, make sure you select 1.

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Option: from the Expire Date list, select a date for the user’s account to expire; this is very 
useful for temporary workers.

Figure 64.  User Entry screen - Main tab

8. Click the Question tab.
9. From the Select a Question list, select one of the available prompts or enter a unique prompt. 

10. On the Answer field, enter the answer to the security question prompt.
11. On the Reconfirm field, enter the same data from the Answer field. 

Figure 65.  User Entry screen - Question tab

12. Click the Save button.

Assigning Report Permission Levels
On the File menu in CGM MEDISOFT, click Report Permissions to open the CGM MEDISOFT 
Reports Permission screen, which is used to set permissions for most reports available in CGM 
MEDISOFT and in the CGM MEDISOFT Reports engine. Permissions for most statements and 
other reports using the .MRE extension, however, are set in the CGM MEDISOFT Security 
Permissions screen. 

NOTE: These options do not appear on the File menu until security has been applied to a practice 
with users created in the Security Setup screen.

When users access the Reports Server or Reports Client, their access level determines what 
reports can be generated or viewed. 

1. Log in to CGM MEDISOFT as a Level 1 user.
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2. On the File menu, click Report Permissions. The CGM MEDISOFT Reports Permissions 
screen appears.

Figure 66.  CGM MEDISOFT Reports Permissions screen

3. As needed, select a report grouping from the left panel of the screen to apply or modify a 
permission setting. The reports associated with the report grouping appear right panel of the 
screen.

4. On the right panel select a report to change or apply a permission setting. As needed, select 
the Level 1, Level 2, Level 3, Level 4, and Level 5 check boxes. You can select multiple 
check boxes (levels).

5. When finished making changes to this report, select others to modify if needed. 
6. Click the Close button when finished. The Information screen appears.
7. Click the OK button. The modified permissions take effect after the user logs off the system 

and logs on again. 

E-mail Setup 
Ues the report server to deliver reports via email. Emailed reports will be sent in Adobe Acrobat 
.pdf format. The Adobe Acrobat reader is available for installation on the CGM MEDISOFT 
installation DVD. The report server uses settings that you enter in the E-mail Options screen.

These network and email facilities are required to use the email feature in the report server: 

 • Access to an SMTP outbound email server (other types of servers are not supported) 
 • Permanent (always connected) Internet connection for the computer running CGM 

MEDISOFT Report Server 



CGM MEDISOFT v28
December 2023 v28 65

Chapter 3 - Automatic Report Generation and Delivery Email Configuration 

To open the E-mail Options screen:
 • On the File menu in Reports Server, click E-mail Options. The E-mail Options screen 

appears.

Figure 67.  E-mail Options screen

Email Configuration 
In the Email Options screen, select and enter data to configure email delivery of reports. Most of 
the settings in this screen rely on your email/network settings and configuration. 

Field Description

SMTP Server Enter the full name of the SMTP email 
server that will be used for outbound 
email. 

From Email Enter the email address of the person that 
generates/supervises reports. This 
information will appear in the From field of 
the email. This email address is used as 
the default name for emailed reports but 
may be overridden in a report schedule. 

Subject Use this to select Report Title, Practice 
Name, or Schedule Name from the 
Subject list, or enter the text to be used for 
the Subject line of email messages. This 
subject selected here is used as the 
default subject for emailed reports but may 
be overridden in a report schedule.
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Troubleshooting
If you have difficulty sending and receiving email, contact your email provider to verify your network 
information, such as SMTP Server, login name, password, port number, and SSL use. In many 
cases, your email provider has documentation on changing email settings such as port numbers, 
SSL, password, and so on.

Also, make sure that your email server is an SMTP/POP3 server. The email server must support 
SMTP/POP3 email.  That means that some popular, free email services will not work.

If you receive a connection reset error message or other generic connection error messages and 
you use a firewall, you may also need to change firewall settings to allow an exception for the 
Report Server.

WARNING: Since changing firewall settings can pose a security risk, consider contacting your 
network administrator before making any changes. 

Reply To Email Use this to enter a Reply To email address. 
In most cases, enter the same email 
address that you entered in the From 
Email field. If you want report recipients to 
reply or send comments to a different 
address than the address used in the From 
Email field, enter the new address in this 
field. 

Login Name Enter your email login name. Contact your 
email provider to find out your login name 
or check your email setup information in 
your main email application.

Password Enter your email password. Contact your 
email to find out your password or check 
your email setup information in your main 
email application.

Confirm Password Enter the same data entered in the 
Password field.

Port Number Use this to enter a port number, if 
necessary. Contact your email provider to 
find out the correct port number or check 
your email setup information in your main 
email application.

SSL Option Use this to select the type of SSL from the 
list, if necessary. Contact your email 
provider to find out if your system uses 
SSL and what type is used (AUTO, SSL, or 
TLS) or check your email setup 
information in your main email application 
to see if SSL is used.

Field Description
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To add an exception to the Windows firewall: 
1. Launch the Control Panel and double-click Windows Firewall.
2. Click the Exceptions tab. 
3. Click Add Program.
4. Select Report Servers. 
5. Click the OK button.
6. Click the OK button.

Importing Reports

Reports must be imported into the CGM MEDISOFT Report Server database to be available for 
scheduling. Reports currently installed for CGM MEDISOFT on a single computer or a network 
can be used directly with the report server. 

Report importation happens both automatically and manually. The report server automatically 
imports reports from its AutoImport folder when it starts. Manual importation is done with a menu 
selection in the report server. 

Automatic Importing
Follow these steps to automatically import a report: 

1. Close the report server. 
2. Place the report definition file or files (filename.rtm) in the CGM MEDISOFT AutoImport folder. 

This folder by default is found at C:\Program Files\CGM MEDISOFT\AutoImport. 
3. Open the report server. 

Manual Importing
Follow these steps to manually import a report: 

1. Place the report definition file or files (filename.rtm) in the CGM MEDISOFT AutoImport folder. 
This folder by default is found at C:\Program Files\CGM MEDISOFT\AutoImport. 

2. On the File menu, click Import Reports from the report server menu.

Note: Reports contained in CGM MEDISOFT report packages must be imported in the same 
manner as a custom report created with CGM MEDISOFT Reports Developer. The installation 
program for each report pack will place the report definition files in the AutoImport folder for 
automatic or manual importation. 
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Scheduling a Report

Schedules Tab 

Figure 68.  Schedules tab

The Schedules tab appears on the main CGM MEDISOFT Reports Report Server screen. This 
lists all currently scheduled reports. Use the controls on the tab to review information about 
scheduled reports, to change report schedules, to delete a scheduled report, or to add a new 
schedule entry. Information about each scheduled item may be viewed directly by enlarging the 
screen or scrolling to the right to view more columns of report information. 

Option Description

Sort By Use this to select the field by which you 
want to sort the list of scheduled reports 
from this drop-down list. 

New Use this to enter a new report schedule.

Edit Use this to edit a report schedule. 

Delete Use this to delete a report schedule. The 
Confirm screen will appear and you will be 
asked to confirm that you want to delete 
the scheduled report with this screen. 

Disable/Enable Use this to stop the automatic generation 
of the report. Click the Yes button on the 
Warning screen to disable the report. Click 
the Enable button to resume regular 
generation of the report.

NOTE: this option is only available in the 
CGM MEDISOFT Reports Server.



CGM MEDISOFT v28
December 2023 v28 69

Chapter 3 - Automatic Report Generation and Delivery Report Schedule Entry

Report Schedule Entry
To open this screen, click the New icon on the toolbar of CGM MEDISOFT Reports Server.

Figure 69.  Report Schedule Entry screen

This screen is used to define a scheduled report. Complete the information required on each tab to 
create or edit a schedule entry. Here is a brief description of each tab:

Field Description

Report Use this to name the schedule entry and select the report and the data set 
to use for the report. 

Schedule Use this to define when the report will be produced. 

Recipient List Use this to select a list of recipients that will view the report using the 
Report Server Client. 

Delivery Use this to print reports on a local or network printer and/or export to a file 
after completion. Define these options on this tab. 

Email Use this to enter a list of recipients to receive the report by email. 

Note Use this to enter additional information to describe the report. 
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Report tab

Figure 70.  Report Schedule Entry screen - Report tab

Field Description

Schedule Name Enter the name of this scheduled report. It is helpful to describe the 
report that will be printed and the practice name used for the schedule 
when CGM MEDISOFT is used for billing with multiple data sets. 

Report Name Click the Select Report button to choose the report for this schedule. All 
currently installed CGM MEDISOFT reports will be shown on the list. 
The report must be available in CGM MEDISOFT to be scheduled. 

Practice Name Select the CGM MEDISOFT data set for which the report will be 
produced. All CGM MEDISOFT data sets available to the computer 
running the report server software will be displayed on this list. 

Schedule Enabled Use this to inactivate a report schedule. A disabled report schedule can 
remain on the schedule without harm. You can also enable or disable a 
report from the Schedule tab using the Enabled check box. See 
“Schedule tab” on page 72.
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Choose Report Filters Click the Choose Report Filters button to create and save the data 
selection questions for the report. All data selection questions appear 
exactly as they would with any CGM MEDISOFT report, with the 
exception of date selection questions. Rather than entering a date for 
the selection question, a time period is selected. Choose from the 
following options: 

 • All (all dates available in CGM MEDISOFT) 
 • Today 
 • This Week (all dates occurring this week between the prior Sunday 

and the current date and time) 
 • This Month 
 • This Year 
 • Yesterday 
 • Last Week (all dates last week between Sunday and Saturday) 
 • Last Month 
 • Last Year 

These time period selections allow a variable date filter that is 
calculated at the time a report is printed and automatically applied to 
the report to show the desired time period. These date filters are 
relative, which means that the time period is different depending upon 
when the report is printed. 

Filters entered in a report schedule are stored permanently with the 
schedule, eliminating the need to enter the filters every time the report 
is printed. 

Field Description



CGM MEDISOFT v28
72 v28 December 2023

Schedule tab Chapter 3 - Automatic Report Generation and Delivery

Schedule tab
Use the Schedule tab in the Report Schedule Entry screen to define when the scheduled report 
will be produced.

Figure 71.  Report Schedule Entry screen - Schedule tab
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Recipient List tab

Figure 72.  Report Schedule Entry screen - Recipient List tab

Users currently set up to receive reports in CGM MEDISOFT Report Server are listed on the left of 
this screen under All Users. Users currently assigned to the scheduled report are listed in the 
Users to Receive Report column. Select a user in either column and then click one of the buttons in 
the area between the columns to move users to the other side. 

Users must be set up in the report server to be able to receive a report through the Report Server 
Client software. 
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Delivery tab 

Figure 73.  Report Schedule Entry screen - Delivery tab

Options on this tab affect printing and exporting of a produced report. 

Printing a Report After Generating 

Select the Automatically print after generating check box to send a produced report to a printer. 
Select the destination printer in the printer list and specify a number of copies.

Only printers with an installed printer driver on the computer running the report server will be 
available in the printer list. 

Exporting a Report After Generating 

Produced reports may be exported to a file after being generated. Select the Export report to file 
after generating check box to export the report. 

Click the Export to button to display a screen to select the type of export file, the name of the 
exported file, and the location for the file. 
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E-mail tab
The E-mail tab is used to define which users will receive reports via email. 

Figure 74.  Report Schedule Entry screen - E-mail tab

Field Description

E-mail report after generating Click the E-mail report after generating check box to enable 
this feature.

New Recipient Enter an email address in the New Recipient field and then 
click the Add button to add the new address to the E-mail 
Recipient List. 

E-mail Recipient List Use this list to display the current list of users who will receive 
a copy of the scheduled report via email. Recipients may be 
deleted from the list by clicking to select the recipient and 
then clicking the Remove button. 

From Email Use this field to enter an email address. This field is by 
default populated with the information in the From Email field 
on the E-mail Options tab. This email address is used as the 
default name for emailed reports but may be overridden on 
this tab. 
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Note tab

Figure 75.  Report Schedule Entry screen - Note tab

Use this tab to track additional information about the report schedule. This information is internal to 
the report and does not appear elsewhere.

Subject This field is by default populated with the information in the 
Subject field on the E-mail Options tab. The subject selected 
here is used as the default subject for emailed reports but 
may be overridden on this tab. If needed, select Report Title, 
Practice Name, or Schedule Name from the Subject list or 
enter the text to be used for the Subject line of sent email 
messages.  

Reply to Email This field is by default populated with the information in the 
Reply To Email field on the E-mail Options tab.  If you want 
report recipients to reply or send comments to a different 
address than the address used in the From Email field, enter 
the new address in this field. 

E-mail Message Reports are emailed in Adobe Acrobat (.pdf) format. Adobe 
Acrobat reader is required to view these reports. The Acrobat 
Reader is available on your CGM MEDISOFT DVD. 

Text entered in this field will be sent as the text portion of the 
email messages generated by the report schedule. 

Field Description
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Ideas for using this tab include: 

 • Recording changes to the timing of the report schedule.
 • An extended description of the group of recipients or the purpose of the report. 
 • Information about recipients added to or deleted from a report schedule. 

Completed Reports

Completed Reports Tab

Figure 76.  Completed Reports tab

This tab displays completed reports. New reports appear in a user's Inbox and may be moved to 
any folder of a user's choosing to save the report for future use. 

Field Description

User Use this to select a user to display reports for viewing.

Sort By Use this to sort the list of completed reports. The list can be sorted by Date 
Created, Schedule Name, Report Name, or Practice. 

Folders Displays the folders. A user's Inbox folder is the recipient of newly generated 
reports. Custom archive folders can be created to store reports for future 
reference. 

Recycle Bin Delete a folder by right-clicking the folder and clicking Delete from the menu. 
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Completed Reports List 

Option Description

Preview Use this button to preview reports to the screen. Double-click any report in the 
Completed Reports list to view the report in a Print Preview screen or click the 
report and click the Preview button. 

Print Use this button to print reports. Reports may be printed from the Completed 
Reports list or from the Print Preview screen. Print a report from the Completed 
Reports screen by clicking the Print button or right-clicking the report and 
selecting Print from menu. 

Send Use this to send a report to another user's Report Server Client by clicking the 
Send button or right-clicking the report in the Completed Reports list and 
selecting Send to User from the menu. 
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While CGM MEDISOFT Advanced and Network Professional give you over fifty standard reports, 
CGM MEDISOFT Reports Professional includes many additional reports that you can use for 
analyzing and understanding your practice. These include sets of Focus Reports that provide 
reports for certain types of practices or certain aspects of a practice. In addition, there is an Aging 
Power Pack that contains reports that can help you manage collections. Facility Financials group 
data by facility; and the Plus Pack contains a variety of reports, such as Patient Account Summary 
and employer reports. 

Standard CGM MEDISOFT Reports

These are reports that come with either CGM MEDISOFT Advanced or Network Professional 
when you purchase that application. 

Day Sheets 
Report Description

Patient Day Sheet   Use this to list each patient’s name, showing all transactions 
and a summary of activities for the day.

Procedure Day Sheet Use this to show a break down by procedure code the 
activities of the day, summarizing patients treated for each 
procedure. 

Payment Day Sheet Use this to list the payments made on the requested day and 
the charges to which the payments are applied.
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Analysis Reports 
Report Description

Billing/Payment Status 
Report (Advanced and 
above) 

Use this to see a thumbnail sketch of the current billing and 
payment status of each claim. The report shows what has 
been billed and not billed, what is delayed for some reason, if 
the carrier is not responsible or has refused the claim, or if the 
claim is paid in full.  An asterisk (*) next to an amount indicates 
that entity has paid all it is going to pay and the balance, if any, 
will go to the next responsible payer.

Insurance Payment 
Comparison (Network 
Professional only)

Use this to compare the payment records of all carriers in the 
practice.

Practice Analysis Use this to see a summary of the activity of a specified period 
(such as a month), listing each procedure performed, the 
number of times it was performed, and the total dollar amount 
generated by each procedure.  It shows the average charge, 
includes any costs involved with that procedure, and 
calculates the net monetary effect on the practice’s income.

Insurance Analysis 
(Advanced and above)

Use this to see a summary of all claims filed by category 
(Primary, Secondary, and Tertiary).  Claims totals are shown 
for charges and insurance payments in both dollar amount 
and percentage.   

Referring Provider Report Use this to display which patients were referred by other 
practices and the percentage each referral contributes to the 
overall referred income of the practice, as of the date of that 
report. The report also includes the UPIN of the referring 
provider. By blanking out the Referring Provider range in the 
Data Selection Questions screen, a report can be generated 
showing what percentage of the entire practice has been 
referred.

Referral Source Report 
(Advanced and above) 

Use this to see a compilation of the patient list by source 
(other than provider) and to see how much revenue comes 
from each source, allowing the practice to identify those 
sources that send profitable referrals and/or limit those that are 
costly or nonproductive.  

Referral Source Report 
Facility Report (Network 
Professional only)

Use this to track patients who are seen at different facilities.  
The Facility Report assembles the patient list by facility and 
shows how much revenue comes from each facility, helping 
you identify which generates the most money/

Unapplied Payment/
Adjustment Report 
(Advanced and above)

Use this to see any payment or adjustment that has an 
unapplied amount and where the transaction can be found.  

Unapplied Deposit Report 
(Advanced and above)

Use this to see all deposits that have an unapplied amount.
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Co-Payment Report 
(Advanced and above)

Use this to see a list of all patients who have co-payment 
transactions.  The report shows the amount of the required co-
payment, how much was applied, and what was left 
unapplied.  If a patient does not have any co-payment 
transactions, he or she is not included in the report.    

Outstanding Co-Payment 
Report (Advanced and 
above)

Use this to see a list of all patients who have outstanding co-
payment transactions. The report shows the Co-payment 
amount expected, the actual amount paid, and the amount 
due. If a patient has no outstanding co-payment transactions, 
he or she is not included in the report.

Appointment Eligibility 
Analysis - Detail Report

Use this to see a list of patients with appointments whose 
eligibility has been checked, based on criteria entered. It 
includes detail about the patients, their appointment date and 
time, the provider name, and reason code. It is an ARRA 
report designed for showing that the practice is verifying 
eligibility electronically.

Appointment Eligibility 
Analysis - Summary Report

Use this to summarize appointments whose eligibility has 
been checked, based on criteria entered. It is an ARRA report 
designed for showing that the practice is verifying eligibility 
electronically.

Electronic Claims Analysis - 
Detail Report

Use this to see the status of claims, providing a summary of 
total claims and those that have been filed electronically or by 
paper. It includes the percentage of claims filed electronically. 
In addition, it shows detail such as the billing date, insurance 
carrier, sequence, claim number, patient chart and name, and 
the status of the claim. It is an ARRA report designed for 
showing that the practice is verifying eligibility electronically.

Electronic Claims Analysis - 
Summary Report

Use this to see the status of claims, providing a summary of 
total claims and those that have been filed electronically or by 
paper. It is an ARRA report designed for showing that the 
practice is verifying eligibility electronically.
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Aging Reports 

Production Reports

Activity Reports

NOTE: This is a Network Professional only feature.

Report Description

Patient Aging Use this to see the aging of your patient’s balances over time. 
This can be printed showing the age of each unpaid transaction 
for patients.  Default aging criteria is based upon the number of 
days between the creation of the transaction or claim and the 
date of the report you are generating.  The columns break 
down the amounts due that are 30, 60, and 90+ days old.  
Aging is from actual date of the transaction, so it reflects the 
true age of the account.  The aging criteria and columns can be 
altered in Program Options.  This report includes all unapplied 
amounts in the totals.  The Date filter has been removed as it 
would return invalid values.  

Patient Remainder Aging 
(Advanced and Network 
Professional only)

Use this to see patient balances without including insurance 
charges. A charge does not show up on Patient Remainder 
Aging until all insurance responsibility has been marked 
complete.

Patient Remainder Aging 
Detail (Advanced and 
Network Professional only)

Use this to see a list of each insurance company on the 
patient’s account and the date the insurance payment was 
marked complete.

Insurance Aging and 
Summary

Use these reports (Primary, Secondary, and Tertiary) to track 
aging of claims filed with insurance carriers.  The summary 
versions are similar but no patient information is included. 

Report Description

Production by Provider, 
Procedure, and Insurance 
and Summary

Use this to see incoming revenue information for each provider, 
procedure, or insurance carrier, respectively. The difference 
between these reports and the summary versions of the 
reports is that the summary reports do not display as much 
detailed information as the regular reports.  The summary 
reports display only a summary of the information available.

Report Description

Daily/Monthly Activity Report Use this to see financial activity based on the date range 
selected. The report displays the total number and the total 
amounts of the charges, payments, and adjustments entered 
during a date range. The report also details the net effect of the 
financial information entered on the Accounts Receivable 
balance for the day/month.
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Collection Reports 

NOTE: This is an Advanced and above feature.

Activity Summary by 
Provider/Insurance and 
Procedure

Use this to see a break down of financial activity by day or 
month.  The summary reports summarize financial information 
entered for each provider/procedure or insurance carrier, 
respectively.

Report Description

Patient Collection Report Use this to see information based on statements marked Sent 
in the Statement Management screen, showing what has not 
been paid, statement date, etc.  Also select Patient Collection 
Report (Statement Notes) to generate the report with statement 
notes included.

Insurance Collection Reports Use this to see claim data on the selected insurance level—
primary, secondary, or tertiary. This report also shows the claim 
data, what amount is outstanding, and so on. These reports 
also offer variants that include claim notes.

Patient Collection Letters Print this report in preparation of collection letters.  It contains 
information from the collection list and is used to help evaluate 
collections.  To access this report, go to the Reports menu, 
select Collection Reports, and then Patient Collection 
Letters.  

Collection Tracer Report Use this to see how many collection letters have been sent and 
when.  Each time collection letters are printed, CGM 
MEDISOFT, by default, keeps track of each letter sent.  
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Audit Reports

Reports in Reports Professional

You can use these reports when you purchase CGM MEDISOFT Reports Professional. They 
include sets of reports that focus on a certain type of practice or a certain aspect of a practice 
(Focus reports), as well as other reports that enhance the reporting capabilities of CGM 
MEDISOFT.

Report Description

Audit Generator Use this to create a Data Audit Report that contains only the 
information you want included in the report. The tables 
available in the Audit Generator are governed by choices made 
in the Audit tab of the Program Options screen and whether a 
table has been edited.  You choose which tables, fields, users, 
and activities are included in the template.  This report is 
intended as a protection for the practice to keep track of 
changes made and, if desired, by whom.

Some PHI (personal health information) will be included in the 
Data Audit Report no matter what selections are made or 
excluded in the Program Options screen or the Audit Generator.

Patient Ledger Use this to see the account status of each patient.  Charges are 
shown until a payment is entered to remove a specific 
procedure paid.  You may include all patient accounts or select 
a few.  The patient ledger is similar to a ledger card in a manual 
accounting program.  Since the CGM MEDISOFT program is a 
true Open Item Accounting program, it can show all or part of 
the financial activity for a patient, including the current balance 
and what procedures have not been paid.  Past activity in the 
account includes a listing of all transactions, indicating those 
that have been paid.  The report marks those transactions that 
have been paid and the amounts.

Guarantor Quick Balance List 
(Network Professional only)

Use this to see a list of the guarantor quick balances that 
appear in the Quick Balance feature.  These balances are the 
guarantor remainder balances. If there are charges that the 
insurance company has not paid on yet, then they are not 
reflected in this report.
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Aging Power Pack

Facility Financials

Report Description

Aging Summary by Billing 
Code

Use this to print a one-line aging summary for current, 30, 60, 90 
and 120+ days aging amounts by patient category.

Date-Accurate Patient 
Aging

Use this to see patient account aging information by date of service 
or statement date, accurate as of any past end of period date.

Limited Period Aging 
Reports

Use this to see reports that include only patients whose balances 
are over 30 days, over 60 days, or over 90 days old.

Patient Aging Sorted by 
Account Balance

Use this to view collection efforts arranged by patients with highest 
account balances.

Report Description

Adjustments by Facility - 
Chart

Use this to print a pie chart showing the proportion of account 
adjustments entered for patients treated at each facility served 
by a practice.

Charges by Facility - Chart Use this to print a pie chart showing the proportion of payments 
entered for patients treated at each facility served by a practice.

Daily Activity Summary by 
Facility

Use this to see a daily summary of charges, payments and 
adjustments grouped by service facility.

Patient Aging by Facility Use this to list patient accounts receivable aging grouped by 
service facility. Two versions are included to age accounts by 
date of service and date of last statement.

Patient Daysheet by Facility Use this to print a patient daysheet grouped and totaled for each 
service facility.

Payment Daysheet by Facility Use this to print a payment daysheet grouped and totaled for 
each service facility.

Payments by Facility - Chart Use this to print a pie chart showing the proportion of payments 
entered for patients treated at each facility served by a practice.

Practice Analysis by Facility Use this to print a practice analysis grouped and totaled by 
service facility.

Procedure Daysheet by 
Facility

Use this to print a procedure daysheet grouped and totaled for 
each service facility.
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Focus on Chiropractic 
Report Description

Financial Statistics Use this print a daily summary report that tracks a practice’s 
financial details including charges, payments, adjustments, 
patient visits, and services performed are all summarized with 
graphs. It includes three versions for current month, current 
year and the prior year periods.

Productivity and Retention 
Statistics

Use this to track statistics on scheduled and completed patient 
visits, new patients, and reactivated existing patients. It also 
tracks patient visit productivity, missed appointments to aid in 
follow-up activities, and quantify reactivated existing patients. 
Includes versions for current month, current year, and prior 
year.

Marketing Analysis - Referral 
Source

Use this to print a summary of new patients, existing patients, 
total patient visits with resulting financial effect by month for 
each referral source. Versions of the report include current and 
prior year periods.

Marketing Analysis - 
Referring Provider

Use this to print a summary of new patients, existing patients, 
total patient visits with resulting financial effect by month for 
each referring provider. Versions of the report are include 
current and prior year periods.

New Patients by Marketing 
Campaign

Use this to show a pie chart comparing the effectiveness of 
each referral source in generating new patients. 

New Patients by Referring 
Provider

Use this to show a pie chart comparing the effectiveness of 
each referring provider in generating new patients.

New Patient Contribution - 
Individual Marketing 
Campaign

Use this to track new patient revenue based one marketing 
effort over time, for instance, an advertisement in a particular 
publication. 

New Patient Contribution - 
Individual Referring Provider

Use this to help you analyze new patient contribution over time 
for one referring provider.

Collection Statistics Detail Use this to see a summary of total charges and collections by 
patient while dividing the report into new patient and existing 
patient groups. Three versions of this report measure month to 
date, year to date and prior year periods. 

Collection Statistics 
Summary

Use this to see a summary of total charges and collections for 
new patient and existing patient groups. Three versions 
measure month to date, year to date and prior year periods. 

Patient Birthday List Use this to print patient birthdays for current month or next 
month. The report also lists patient demographic information. 

Patient Birthday Labels Use this to print mailing labels using the patient birthday list 
data.
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Focus on Managed Care

Focus on Financials

Report Description

Insurance Pay Analysis Use this to see a comparison of procedure charges, allowed 
amounts, payments, and average days to pay. Major grouping 
by procedure, summary totals for each insurance carrier or 
plan.

Procedure Payment Analysis 
By Carrier

Use this to analyze all procedures billed to an insurance carrier 
or plan, reports capitated and fee for service charges, 
payments and adjustments by carrier. 

Patient Census By Carrier Use this to see the patient count impact of a plan. It includes a 
major data grouping by insurance plan, detail listing of each 
patient member of the plan. 

Patient Census By Carrier, 
Provider

Use this to see provider subgroupings to the Patient Census By 
Carrier report.

Insurance Plan Profitability 
Analysis

Use this to print detailed information by carrier with billed 
procedures, payments, adjustments, patient payments and net 
profit based upon standard cost. Both fee for service and 
capitated plans are supported.

New Patients By Carrier 
Chart

Use this to see the plan membership of newly acquired 
patients. 

Charges By Insurance Type 
Chart

Use this to analyze the distribution of a practice's fee for service 
charges by insurance carrier type.

New Patients By Month Chart Use this to print a chart that analyzes new patient count by 
month. 

Report Description

Flash Report - Month To Date Use this to see a daily one page all-in-one report. It can print 
daily totals of charges by type, payments by source, 
adjustments, and charts for daily charge and payment trends.

Flash Report - Year To Date Use this to see a monthly all-in-one report. It can print monthly 
totals of charges by type, payments by source, adjustments, 
and charts for monthly charge and payment trends.

Provider Charge Comparison 
Table

Use this to see a procedure charge comparison by provider 
with monthly and yearly totals.

Daily Provider Activity Detail Use this to print a daily financial report grouped by provider 
with detailed charge, payment and adjustment listings by 
patient. 

Daily Provider Activity 
Summary

Use this to print a daily financial report grouped by provider 
with charge, payment and adjustment summary totals by 
patient. 
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Provider Financial Report Use this to create a provider-specific listing of monthly charges, 
adjustments, payments and withholds. Includes monthly net 
change in accounts receivable. 

Charge Trend Chart Use this to print a chart that shows a practice's procedure 
charges over a specified time period.

Payment Trend Chart Use this to print a chart that shows a practice's receipts (all 
types) over a specified time period.

Adjustment Trend Chart Use this to print a chart that shows a practice's account 
adjustments (all types) over a specified time period.

Combined Financial Trend 
Chart

Use this to print a chart that combines charges, payments and 
adjustments trends. You can produce it for any time period.
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Focus on Marketing and Promotion

Plus Pack 

Report Description

Marketing Analysis - Referral 
Source

Use this to print a summary of new patients, existing patients, 
total patient visits with resulting financial effect by month for 
each referral source. Versions of the report include current and 
prior year periods.

Marketing Analysis - 
Referring Provider

Use this to print a summary of new patients, existing patients, 
total patient visits with resulting financial effect by month for 
each referring provider. Versions of the report include current 
and prior year periods.

New Patients by Marketing 
Campaign

Use this to print a pie chart comparing the effectiveness of 
each referral source in generating new patients. 

New Patients by Referring 
Provider

Use this to print a pie chart comparing the effectiveness of 
each referring provider in generating new patients.

New Patient Contribution - 
Individual Marketing 
Campaign

Use this print a chart of new patient revenue based on one 
marketing effort over time, such as a advertisement in a 
particular publication. 

New Patient Contribution - 
Individual Referring Provider

Use this to help you analyze new patient contribution over time 
for one referring provider.

Patient List by Zip Code Use this to print a list of patients by zip code.

Patient List by Zip Code with 
Patient Totals

Use this to show total billing by patient in each zip code.

Patient Labels by Zip Code Use this to print labels based on a specific zip code. 

Patient Attrition Report Use this to print a list of patients that have not been seen for a 
defined period of time. 

Patient Attrition Labels Use this to print mailing labels based on patient attrition data. 

Patient Birthday List Use this to see a list of patient birthdays for the current month 
or next month. The report lists patient demographic information 
for use in relationship-building activities.

Patient Birthday Labels Use this to print mailing labels based on the patient birthday 
list. 

Report Description

Attorney Summary Use this to print a summary report with one page per patient 
with each charge and their detailed payments and adjustments.
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Collection Detail by 
Procedure Code

Use this to create a report that will show collection information 
by procedure code. Filter the report by a range of service dates 
and a range of payment dates. Reports on charges made in 
one period and payments received in another. 

Collection Summary by 
Provider 

Use this to print a provider grouping of charges and collections 
for those charges from different periods.

Collection Summary by 
Procedure Code

Use this to print a summary of collections by procedure code. 
Filter the report by a range of service dates and a range of 
payment dates. Reports on charges made in one period and 
payments received in another. 

Daily Appointment Count by 
Reason Code

Use this to print a listing of appointments by reason code.

Daily Deposit Summary Use this to print a listing of deposits entered by day and type.

Immunization History Use this to print a report of all procedures performed for a 
patient that fall in the procedure code range for immunizations. 
This report will print one patient per page.

Insurance Payments by Type Use this to see a summary of payments in a date range by 
insurance carrier type.

Insurance Payments by Type 
- Chart

Use this print a pie chart of insurance payments by type.

Overpaid Charges Use this to produce a list of overpaid charges with summary 
payments and adjustments by source.

Patient Email Export Use this to export patient email addresses. 

Patient List by Outside 
Primary Care Provider

Use this to create a list of patients by outside PCP.

Patients by Outside Primary 
Care Provider - Chart

Use this to print a pie chart of outside primary care providers by 
patient count.

Patient List by Primary 
Diagnosis

Use this to create a list of patients by the primary diagnosis in 
billing transactions.

Patient Mailing Labels - Zip 
Sort 

Use this to print mailing labels by zip code. 

Patients by Zip Code - Chart Use this to print a list of patients by zip code in pie chart.

Practice Analysis Grouped by 
Account Code 

Use this print to a report of charges, payments, and 
adjustments in a practice’s general ledger by account code.

Procedure Code 
Reimbursement 

Use this to print a listing of procedure code reimbursements 
from all sources.

Procedure Code Units by 
Month 

Use this to print a monthly table, listing a year’s information on 
quantities of services performed.

Procedures Billed Pie Chart Use this to print an analysis of the number of procedures billed 
during a time period.

Remainder Statement (with 
Aging)

Use this to print a plain paper format of the patient remainder 
statement with remainder balance aging. 
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Remainder Statement 
(Insurance Pending)

Use this to print a plain paper format of patient remainder 
statement with detailed charges that are pending insurance 
response. Note: Does not work internally with CGM 
MEDISOFT statement management functions.

Remainder Statement 
(Insurance Pending Day 
Summary)

Use this to print a plain paper format of patient remainder 
statement with balance currently due from patient and other 
charges that are pending insurance. Note: Does not work 
internally with CGM MEDISOFT statement management 
functions.

Unapplied or Partially Applied 
Adjustments

Use this to print a report of account adjustments that have been 
entered but not applied.

Unapplied or Partially Applied 
Payments 

Use this to help you with open-item accounting, by confirming 
that payments have been completely applied.

Unbilled Secondary/Tertiary 
Claims 

Use this to see a list of secondary or teritary claims for which a 
response was received from the primary carrier but have not 
yet been billed. 

Appointment List with 
Remainder Balance 

Use this to see a list of standard appointments from Office 
Hours with the patient remainder balance. 

Employer Statement Use this to print a bill when employers are paying for a patient's 
services.

Guarantor Mailing Labels Use this to print guarantor mailing labels on standard Avery 
5160 (and compatible) address labels. It also lists the patient 
for whom the guarantor is responsible.

Patient Account Summary 
(with Drill Down)

Use this to see all payments and adjustments categorized by 
source that have been applied to a charge. This version of the 
report offers a click-to-display drill-down area to show payment 
and adjustment detail.

Patient Account Summary Use this to see all payments and adjustments categorized by 
source that have been applied to a charge.

Patient List by Attorney Use this to print a list of patients grouped by attorney.

Private Pay/Insurance 
Financial Comparison 

Use this to see a summary of charges, payments and 
adjustments by insurance category. It also includes cash (no 
insurance assigned) cases in the analysis.

Private Pay/Insurance Patient 
Census Detail

Use this to see a list of patients grouped by insurance category 
with an additional section for cases with no insurance.

Private Pay/Insurance Patient 
Count

Use this to print a summary count of the number of cases 
assigned to each insurance category with an extra grouping of 
cases with no insurance assigned.

Zero Balance Open Cases Use this to see a list of open cases where all charges have 
been paid or adjusted. 
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This section defines terms used in the CGM MEDISOFT v28.

Advantage Database
This is the database that is used to store and manage your practice data in CGM MEDISOFT. It is 
accessed by Reports Professional when you create and print reports.

Band
This is a section of a report, such as the Header or Footer. Your reports will also have a Details 
band where data will be displayed.

Data Pipeline
This is a term used in Reports Professional to refer to a query created in the Query Wizard or the 
Query Designer

DB
This is an abbreviation for Database. 

InstallDef.ini
This is a file that will go on any CD/DVD you make for distributing your reports. It contains 
information regarding who made the report, that person’s company/practice, and contact 
information.

POP3
Post Office Protocol (POP) is an Internet standard protocol (set of formats and regulations) used by 
local e-mail clients to retrieve e-mail from a remote server.

RAP
Report Application Pascal is a programming language that CGM MEDISOFT Reports Professional 
uses on the Calc workspace for handling calculations and data manipulation.

SMTP
Simple Mail Transfer Protocol (SMTP) is an Internet standard for electronic mail (e-mail) 
transmission across Internet Protocol (IP) networks.

SQL
Structured Query Language is a programming language designed for managing data in relational 
database management systems.

SSL
Secure Socket Layer is a protocol for encrypting information over the Internet. It ensures that your 
mail is encrypted and protected.

System Tray
This is the set of icons located on the Windows screen at the bottom right. 
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